COMPSCI 111 /111G

Mastering Cyberspace:
An introduction to practical computing

Word Processing

ASCII
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American Standard Code for Information Interchange.
+ Code used to represent English characters as numbers
+ There are 127 characters
+ Codes for A-Z, a-z and 0-9 are contiguous

Some of the ASCII codes

65| |1 (73 |AQ |81

A

B |66 J |74 R |82
C |67 K |75 S |83
D |68 L |76 T (84
E |69 M |77 U |85
F |70 N |78 V | 86
G |71 O (79 W | 87
H |72 P |80 X |88

http://en.wikipedia.org/wiki/ASCII
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Text Editor

Text Editor
» Allows user to edit the characters on the page
+ Plain text (ASCII)

& TeutPad - [£5,111_GenEd) 1 11 Course Book\LabesSaurce Chapter_Hard . =] 5]
T Fie Edk Semch View Took Macros Configure Window Help =|8] %
OFd B&RE| ! BT WM aT @V Ul TR e » (W2
1 “chaptes[Conpuler Hardwars) %

waindtos

1k computer systea consists of both hardvare and soltvare. Coapuler hardvare is
the physicel equipment that mekes up a computer system. Some people call this
the stull you can kack' In this chapter. wve vill lock at the hardvare used in
& typical computer system

bagin{canter)
~includegraphics{Figures Bardvare_ComputerSysten eps)
“end{center}

Arehiteeture,
mply an electronic machine that can manipulate numbers by
folloving sisple instructions. For exasple, s cosputer can add. subtract
nultiply end divide It can compare nunbars snd no thea from cne place to
another ost of these tasks are perforsed by a central processor

& nunber of additicnal components are required 5o t we Can use computer systems
sitectively Thess components perfors jobs such as branslating information
betveen humans and computers (input and cutput), smnrn information, and
transferring informaticn betueen different computers. In this secticm, we will
discuss vhat the most important pieces of hardvare do

5 “begin{center}

includegraphics{Figures-Hardvare Organisation. eps})

wraxtsl{Components of & typical computer system}
“mnd {center}

.I.i “subsection({Frocessing) _Ij

For Help. press FI 14 1

http://en.wikipedia.org/wiki/Text_editor

Word Processors
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Word Processor
» Extension of a text editor
» Allow user to format the document (change the appearance of text)

Fonts
+ Style, size, typeface

Paragraph
* Alignment, spacing

Document
* Margins, Headers, Footers

http://en.wikipedia.org/wiki/Word_processor
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Standards

Each word processor decides how to store information

+ Uses special codes to identify the format of the text
— Bold, italic
— Font size
— Alignment

« File is saved with these codes

Standards
* Proprietary (MS-Word)
* Open standard (Open Office)

What you see is what you get

WYSIWYG (Whizzy-wig)
» Graphical User Interface
* What the user sees is the same as the output printed

Most modern word processors work this way
* Microsoft Word

* Open Office

Pl el W mam w1 g

http://en.wikipedia.org/wiki'WYSIWYG
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Postscript printers Using Microsoft Word
Postscript Page Layout
» Language used by Laser Printers * Make sure that you are creating an A4 page
+ Tells the printer how and where to display text » Page Setup from the File menu
+ Created in 1985
» Started Desktop Publishing revolution Different views
T — T 3 WordFrocesTATe
Q@ ISRED A - WA DT DT HR FFR e W L%-F:‘;.y;‘_\u;:.h.v;:;,.:;..:.".;;........\...."_..“...m..._»-u S
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Setting Preferences

Basic Features of a Word Processor

Tools — Options 15 Editing Text
Track Changes | User Information | Compatibility | File Locations | * WO rd Wra p i
Automated Features view | Gereral | Edt | Pt | Save | Speling & Grammar « Insert/ Delete Insert Point/ Cursorﬁ
Page Layout view options
. sh . i
Auto Save i = e Select Text for action Hello|
. Auto Format [~ Object anchors [~ Bookmarks
™ Text boundaries ™ Eield codes
« Auto Spe”ing correction I Ficture placeholders Figld shading; C|ipboard
. . ¥ Apimated text when selected - . .
* Non-printing characters ¥ sereentis + Keeps one clipping
Monprinting characters
I~ Tab characters ™ ptional hyphens * CUt, Copy, Paste yyyy
[~ spaces I Hidden text C||pboa rd
™ Paragraph marks ¥ al yyyy
Windau Formatting
¥ Status bar ¥ Harizontal scroll bar \
¥ wertical ruler v vertical scroll bar . Character 1
. - Paragraph xxxxxxx Paste XXXXXXX
This text has tabs and spaces « Document iz R\ | Xo0xxxx
. |
Notice the marker used for the paragraph [ yyyy
XXXXXXX yyyy
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Find and Replace Spelling and Grammar
Useful for repetitive changes Check as you type
» Spelling 2x]
Find and Replace x| . Grammar autaCorrect | AutoFarmat &s You Type I AutaText | AutoFormat |
Find  Reglace | Gt | [V Carrect Two Thitial Cépitals Exceptions. .. |
Find what: I\ ;I _ . [~ Capicalize first letter of sentences
iZancel I Sorue mw&'m this Waﬁ spelt WIng, V¥ Capitalize names of days
Replace with: I LI el I ¥ Correct accidental usage of caP5 LOCK key
e ¥ Replace text as you bype
REDLI i this )} Replace: With: & Plaintext ¢ Formatted text
Search: all =) [~ Match case Less 2 | &‘mmt sentence are Spe t WIDLE. Ithe IHshs..‘ the phantom strikes again|
I~ Find whole words anly
F ?;Eﬂ:?:;ds thecampany the campany d
o hefirst the first
Repl I™ Find all word forms thegovernment | the government
B AutO COI'I'eCt their are there are
Mo Formatting | Farmat ™ | Special ~ i . heir is thereis [
« Common m|Sspe|||ng themselF themselves
themselfs themselves j
* Abbreviations
. . , Add Delete |
Note: Some applications can’t Undo a Replace All
Ok Cancel
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Formatting

Toolbar Normal ~ Times -1z - B I U

Toolbar Normnal - Tirmes -1z - B I 10

Dialog Box (from Format menu) O

21|

Format | Tools Table wWindow  Hel Font | Character Spacing | Animation |
A Fort... Font style:
Y oo Appearance of Text [ragur
2= Bullets and Numbering. ..
Borders and Shading... * Typefa ce
S « Style (Bold, Italic)
Tabs... ; . i L B Color:
Menu + Size (in points) [frere) = W =
A Effects
I . COIOU r I™ strikethrough I shadow [ small caps
Change Case... I” Double strikethrough I~ outline [~ allcaps
Background » « Effects I™ Superscript I~ Emboss I~ Hidden
- I™ subscript I~ Engrave
L% Theme... Preview
Frames 3 .
'/i] AutoFormat. .. spac'“Q 1905
Iﬁ Styles and Formatting... ° Kern | ng
1"4‘ Reyeal Formatting, .. Shift+F1
This is a TrueType font, This Font will be used on both printer and screen,
Default. .. I Cancel I
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Paragraph Indenting Paragraphs
Toolbar Hanging Indent
. |-|-O-|-]-|-é-|.3
Dialog Box (from Format menu)
D
2%

Appearance of Paragraph

Indents and Spacing | Line and Page Breaks I

Qutling level: Body text *

Special:

By
I(none) j I

=

Line spacing: Ak

+ Alignment dopmer: -]
. SpaCIng Inl:::::atlnn — .
* |ndent Right: e =
Spacing
Before: 0pt =
After: IU pt ﬂ
Preview

ISingIs j I

=

D Mhas i e bt pramrg e in e LEim 19581

Tabs...

Conel
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A word processor allows you to create, view, edit, format, print and store text. MMost modern
word processors have many advanced and Microsoft Word is no exception
Seme of these features are mcredibly useful, while others are not. We will look at
some of the more commen fratures here

First Line Indent

QA L oword processor allows you to create, view, edit, format, print and store text.

Most modern word processors have many advanced and Microsoft Word iz no exception
Some of these features are incredibly useful, while others are not. We will look at some of the
meore common features here.
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Format Document

File Menu — Page Setup

Margins
Paper size, orientation

Margins ’_

Paper size

|A4 'I
Width: 21 cm 5‘
Height: 29,7 cm E‘

rigntation
& Portrajt
€ Landscape

21|

Paper Source I Layout I

Borders and Shading

review |

\

Apply to whole document

apply ko |whole document hd

Default... |

Conce
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Applies to either:
« Paragraph
* Whole Document

Borders and Shading 2

Page Border | Shading |

Setting: Style: Preview

iZlick on diagram below or use
buttons ko apply borders

I Wph —— - Apply to:
g—ﬂ Custom

& = [Paraqraph |
Options... |

Shaw Toolbar | Cancel |

1/08/2006 COMPSCI 111/111G - Lecture 08 18
Set the number of columns Page Breaks [
+ Forces a new page to start Insert
O (et
One Section breaks
— Column Column break [ tptpeae € Enpade
rPreset: Continuous Odd page
| | + Forces a new column to start
Cance Cancel
one r Three TWO
Mumber of columns: m I™ Line between H
— Columns Section Break
i and spacing revi .
T a— p— * Forces a new section to start
i s = = ] « New section starts on
=2 = Three
. . — sam
= = Columns same page
¥ Equal calumn width I — next page g
Apply to: IWhn\e document - I~ start new column - neXt Odd page R
Four — next even page
Columns
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Header and Footer

Footnote/ Endnote

Add content to top/ bottom of every page

Toolbar used to add Page Numbers, Current Date etc.

Header and Footer

A W & O A& =F T 5, | Cose

Insert AutoText =

Note: Must be in Print Layout view to see Header/ Footer

References
+ At bottom of page (Footnote)
* At end of document (Endnote)

Footnote and Endnote i |
Insert

ol ;Eb‘b‘&ﬁ'u"t"s'} Bottom of page

£~ Endnate End of dacument
MNurmbering

& auitolumber 1,23

" Custam mark:

Symbal...

o] I Cancel I Options. .. |
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Surface/ Physical Style sheet accessed via the toolbar
. Mormal |7 -
* Make changes directly Arial, bold, 16 pt~T——— [ =g
. - Caption 2
¢ eg. Arial, 24 pt, bold, centered Arial, bold, 16 pt~T— To apply a style [ - = p.“
Arial, italic, 12 pt] » Select text Heading 1 14 pt
TV A = 1
. Arial, bold, 16 pt~—— » Choose style from drop down menu Heading 2 14t
Structural/ Logical Y P s —
. Heading 14 pt
+ Assign a style to each block of text —
. _ _ Advantages Hormal T
* e.g. Heading1, Fish Names, Captions + Apply many changes at once Lecture Notes Subheading =, 1
" ST T s e = 14 pt
« Define how the style looks (Style sheet) . Consistency —
BES 12 pt
* Easy to alter style Body Tor =1
Heading 1 ~T——— Style Sheet Prrp Tond B ::8 DT
Section Heading | ',:,':' Heading 1: Arial, bold, 16 pt Eaiy BEnd o
Subheading | Section Heading: Arial, bold, 16 pt - Font = a
Heading1 ~|——— Subheading: Arial, italic, 14 pt e
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Creating/ Modifying a style

Choose Styles and Formatting from the Format menu
+ Click on New Style

Formatting a Style

Choose Paragraph or Character style type

e ———— Specify the formatting you want =
SEF TS a &R D] - @) s
[F]rewsrar - ais =16 U ExamizE®o-v-A- Fnp . FOI’T[ Propetties
B comvmt o oe [ Mame: Im
Y RO R e = « Paragraph - |
R
I ) ) ing of selexted tent . Border Style based on: I 1l Heading 1 =
: ot e |Hea Nga 1 « Tabs Style for following paragraph | stvlel -
: F Select Al | | Mew Style.... Formatting
: J R G + Numbering o ) |
= : I o (_.e.lrl:rmamlg == = %":: :‘
'1 . Foctw B The doubling cuba
B Header "
; = Heading 1 1
. |.I|r-.5nl\ s--?nll Heading 2 T
8 = :""‘J.\"'“ =] Heading 3 ' . Heading 1 +
-‘:;E;]iu;l”“h_ == _‘ T [_:’ R pp—— ™ add to template ™ Agtomatically update
Page s S E A A EEm mE CdB " 4 Format - | Cancel
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Bibliographic Database Create a new EndNote library
« Maintain database of references « Used to store references
« Add citations to documents
+ Consistent referencing / bibliographic information fnoote ! l
~Get started with EndMate 7
‘ BUI|t-In styles ig % Create a new EndMNote library
Advantages @ " See what's new in EndMate 7
. COﬂSIStenCy é € Open an existing EndMote library:
» References are stored electronically | ElE
« Easy to alter formatting for different publishers / subjects oo
o rot display this message again
+ Good once you learn —
» University of Auckland has site license
— Free for students to use at home
— Courses on EndNote from Student Learning Centre
Disadvantages
* Not easy to learn
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An empty library

RI=EY

File Edit References Tools ‘Window Help

Adding a new reference manually

Choose References — New Reference
+ Select the type of reference (Journal article, Book, etc.)
* Enter the data into the appropriate fields

D& iEadiisf8nm| v |E ||l Elinz| _
[Fonfot  clfFensee ]| 7 U P & A £ | SE=IE
¢ Backgammon.enl Bold ol x| E E Reference Type: |Joumal Atils -
B | Author | rear [ Tite uther: =
Year:
Title:
[ Journal:
Volume:
Issue:
Pages:
Date:
Type of Article:
| 0|
|Showing 0 out of 0 references, | ¥ ShowPreview ELLIITLS
Alernate Journal: =
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Importing a reference Connecting to online libraries
Find the article in an online library Search online libraries directly
* Get the EndNote citation (often provided) » References are imported into the EndNote database
+ Save it to the disk as "Plain Text" * Voyager uses this system
+ Choose File — Import
+ Select the file, and choose "EndNote Import" + Tools — Connect — Voyager
=
I Chess and backgamenen - Mozl ireos = ) [t & Commition e e
B [R Wew G0 [Docknas ok e Tmtes crewd €) * Mapon Dista File: Chs_send_backgomeson_sstoreres|  Choe ™ [ - [x]
@-gp- & ‘?,\ [ Wmciiportat ocm arpickation. dwmt DiS 28 88ccbs. %] (3 6o [IGL : M ﬁsmafuﬁw“ :::’.:Ir::f
U ol Yed, Litwaey Catilony
| L o e - e .| W Foote - Whpasa the .|| Chess sl backigaranon | 3 Ispont Oon: [Eraticts Irgort = e Trakgea e gLt
T ——r—— - . o= - i : L
;O The ACM Duglal Library T T, Tert Tomnelaiort i Trorei 7] :'l- r“;:;‘uesu L::’;[:m‘
. . [ ] oo Ty, e
i Wawe Sl o i Mot —
Iwleb ol Sienca 151 151 -
Chess and backgammen | Careel |
Fulltent e gorian % s
Seurce  ACM SIGART Dulletin worn
o s ot s
futhar Lo E . PR, PR Basad Ore o
Publisher ATM Fres b o, L Camngaay
Commaniz
Tooks and Actions: ind s [T il
5i Adich to 3 B Display Formats- BiTax [EndHotd AC Ref -
4 0 :
& Fnd: [wen O Pt 3 e provios [ gt 1 nghcs
| Dene 3
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Connecting to online libraries (2)

Using the citations

Select the entries you require and "Copy References to EndNote"
» Entries are added to the database

==

File Edit References Tools ‘Window Help

DES| iR FBYR U |E E||moe =liwe|
IP\am Fort le’Iain Size jl B I IO P | A A F |
l#l Connected to: University of Auckland Library Catalog at Universil _|EI LI
| Dane Copy 7 References To~ -
Author |Year |T|t|e

Barrio

Lygens 3 COfthe Ias of chance or, a method of calculation of the he

| | -l

F sShow Preview v

|Shﬂwing 10 out of 10 retrieved references. |

Start a MS-Word document

or

Click cursor at the point to enter a citation
Select “Find Citation” from toolbar

RILE T LGN

Tools — EndNote — Find Citation

Select the reference and click Insert

=i
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Using the citations (2)

Finalizing the document

Alternate method
« Start Endnote
+ Select one of the citations
» Start the Word document
» Choose Insert Selected Citations

Once all citations are complete
Choose Format Bibliography

Updates all the Citations
Uses the style selected

Output Styles

Defined for all major publishers

Author and Date

Falkener, E. (1961). Games ancient and
oriental. and how to play them;

being the games of the ancient

Egvptians, the hiera gramme of the

Greeks, the ludus latrunculorum of

the Romans, and the oriental games

of chess, draughts, backgammon,
and magic squares. New York,
Dover Publications.

Hans, B. (1980). "Backgammon program
beats world champ." SIGART
Bull (69): 6-9.

Falkener, E. (1961). Games ancient and
oriental, and how to play them; being the
games of the ancient Egyptians, the hierg
gramme of the Greeks, the [udus
latrunculorum of the Romans, and the
oriental games of chess, draughts,
backgammon, and magic squares. New
York,; Dover Publications.

Hans, B. (1980). Backgammon program
beats world champ. SIGART Bull.(69), 6-9.

Numbered

1 Falkener, E., Games ancient and
ortental, and how to play them;
being the games of the ancient
Egyptians, the hierg grammie of the
Greeks, the Judus larunculorum of
the Romans, and the oriental games
of chess, draughts, backgammon,
and magic squares. 1961, New
York,_: Dover Publications. 366.
Hans, B.. Backgammon program
beats world champ. SIGART Bull.,
1980(69): p. 6-9.

o
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